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PIC32 USB Starter Kit III Information Sheet

The PIC32 USB Starter Kit III (DM320003-3) provides a low-cost method for the
development and testing of USB Host and Device applications with PIC32MX430/
450/470 devices. This evaluation kit includes the PIC32 USB Starter Kit III board,
standard A to mini-B USB cable for the debugger, standard A to micro-B cable for
the USB application development, three user-programmable LEDs, and three push
button switches.

Installing MPLAB® IDE and C Compilers
The MPLAB Integrated Development Environment (IDE) should be installed prior to
using the PIC32 USB Starter Kit III. While MPLAB IDE provides the assembler tools
for development, the Microchip demonstration code requires installation of a C
compiler. Microchip’s MPLAB C Compiler seamlessly integrates into MPLAB IDE.
Both the MPLAB IDE and MPLAB C Compiler are free (see the following note) and
are available for download at www.microchip.com/MPLAB and www.microchip.com/
compilers, respectively.

Microchip Demonstration Code and More Information
For the free Microchip demonstration code and more information, please visit the
PIC32 USB Starter Kit III page at: www.microchip.com. From the Design menu, click
Development Tools. Then, from the Starter Kits menu, click Starter Kits, and then
click PIC32 USB Starter Kit III. From the downloads section, select the desired
device application.

Running the PIC32 USB Starter Kit III Demonstration Code
After downloading and installing the Microchip development tools, please refer to the
README.txt file in the demonstration folder for instructions on running the code.

Note: Standard Evaluation (Free) – All optimization levels are enabled for 60
days, but then revert to optimization level 1 only.
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OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicitly or otherwise, under any Microchip
intellectual property rights.

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our 
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts 
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
starter kit. Items discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the PIC32 USB Starter Kit III (i.e., starter kit) as a 
development tool to emulate and debug firmware on a target board. This user’s guide 
includes the following chapters:

• Chapter 1. “Introduction” provides a brief overview of the starter kit, highlighting 
its features and uses.

• Chapter 2. “Hardware” provides the hardware descriptions of the starter kit.
• Appendix A. “Board Layout and Schematics” provides a block diagram, board 

layouts, and detailed schematics of the starter kit.
• Appendix B. “Bill of Materials” provides the bill of material descriptions and the 

reference, manufacturer, and part numbers for the components used in the starter 
kit hardware.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Italic characters Referenced books MPLAB IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File > Save

Bold characters A dialog button Click OK

A tab Click the Power tab

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be any 
valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

Notes A Note presents information 
that we want to re-emphasize, 
either to help you avoid a 
common pitfall or to make you 
aware of operating differences 
between some device family 
members. A Note can be in a 
box, or when used in a table 
or figure, it is located at the 
bottom of the table or figure. Note 1: This is a note used in a 

table.

Note: This is a standard 
note box.

CAUTION

This is a caution note.
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RECOMMENDED READING

This user’s guide describes how to use the starter kit. The following Microchip 
documents are available and recommended as supplemental reference resources.

PIC32MX330/350/370/430/450/470 Family Data Sheet (DS60001185)

Consult this document for detailed information on PIC32 devices. Reference 
information found in this data sheet includes:

• Device memory maps

• Device pinout and packaging details

• Device electrical specifications

• List of peripherals included on the devices

MPLAB® XC32 C/C++ Compiler User’s Guide (DS50001686)

This document details the use of Microchip’s MPLAB XC32 C/C++ Compiler to develop 
an application.

MPLAB® X IDE User’s Guide (DS50002027)

Refer to this document for more information pertaining to the installation and 
implementation of the MPLAB X IDE software, as well as the MPLAB SIM Simulator 
software that is included with it.

Universal Serial Bus Specification and Associated Documents

The Universal Serial Bus is defined by the USB 2.0 specification and its associated 
supplements and class-specific documents. These documents are available from the 
USB Implementers Forum. See their web site at: http://www.usb.org

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at: http://www.microchip.com. This 
web site makes files and information easily available to customers. Accessible by most 
Internet browsers, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listings

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listings of seminars and events; and listings of Microchip sales 
offices, distributors and factory representatives
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 
tools

• Emulators – The latest information on the Microchip in-circuit emulator, MPLAB 
REAL ICE™

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debugger, MPLAB ICD 3

• MPLAB X IDE – The latest information on Microchip MPLAB X IDE, the 
Windows® Integrated Development Environment for development systems tools

• Programmers – The latest information on Microchip programmers including the 
PICkit™ 3 development programmer

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

http://www.microchip.com
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DOCUMENT REVISION HISTORY 

Revision A (June 2013)

This is the initial release of the PIC32 USB Starter Kit III User’s Guide.

Revision B (October 2013)

The PIC32 device was updated to the PIC32MX470F512L. All updates in this revision 
reflect this change throughout the document.
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Chapter 1.  Introduction

Thank you for purchasing the Microchip Technology Inc. PIC32 USB Starter Kit III. This 
board provides a low-cost, modular development system for Microchip’s line of 32-bit 
microcontrollers. 

The starter kit is preloaded with demonstration software for the user to explore the new 
features of the PIC32. It is also expandable through a modular expansion interface, 
which allows the user to extend its functionality. The starter kit also supplies on-board 
circuitry for full debug and programming capabilities.

This chapter covers the following topics:

• Kit Contents
• PIC32 Functionality and Features

The preprogrammed example code on the PIC32 MCU is available for download from 
the Microchip web site at http://www.microchip.com. All project files have been included 
so that the code may be used directly to restore the PIC32 MCU on the starter kit to its 
original state (i.e., if the sample device has been reprogrammed with another program).

1.1 KIT CONTENTS

The PIC32 USB Starter Kit III contains the following items:

• PIC32 USB Starter Kit III Development Board
• USB mini-B to full-sized A cable – USB debug cable to debug and power the 

board
• USB micro-B to full-sized A cable – PIC32 USB cable to communicate with the 

PIC32 USB port

Note: If you are missing any part of a kit, contact a Microchip sales office for 
assistance. A list of Microchip offices for sales and service is provided at 
the end of this document.
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1.2 PIC32 FUNCTIONALITY AND FEATURES

Representations of the layout of the PIC32 USB Starter Kit III are shown in Figure 1-1 
and Figure 1-2. 

The top assembly of the board includes these key features, as indicated in Figure 1-1: 

1. PIC32MX470F512L 32-bit microcontroller (U1).

2. Green power indicator LED (D7).

3. On-board crystal (Y1) for precision microcontroller clocking (8 MHz).

4. USB Type mini-B receptacle for on-board debugger communications (J3).

5. Green PICkit™ On-board (PKOB) debug indicator LED (D6).

6. Three push button switches, SW1, SW2, and SW3, for user-defined inputs (S1, 
S2, S3).

7. Three user-defined indicator LEDs, LED1, LED2, and LED3 (D3, D4, D5).

8. USB Type A receptacle for PIC32 host-based applications (J5).

9. HOST mode power jumper (JP1).

10. Regulated +3.3V power supply for powering the starter kit via USB or expansion 
board (U3).

FIGURE 1-1: PIC32 USB STARTER KIT III LAYOUT (TOP VIEW)

Note: When running USB device applications, open the jumper JP1 to prevent 
possibly back-feeding voltage onto the VBUS from one port on the host to 
another (or from one host to another).
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The bottom assembly of the board includes these key features, as indicated in 
Figure 1-2: 

1. PIC24FJ256GB106 for PKOB debugging (U2).

2. Connector for various expansion boards (J1).

3. USB Host and OTG power supply for powering PIC32 USB applications (U5).

4. USB Type Micro-AB receptacle for OTG and USB device connectivity for PIC32 
OTG/device-based applications (J4).

FIGURE 1-2: PIC32 USB STARTER KIT III LAYOUT (BOTTOM VIEW)
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Chapter 2.  Hardware

This chapter describes the hardware features of the starter kit.

2.1 HARDWARE FEATURES

The key features of the PIC32 USB Starter Kit III are listed below. They are presented 
in the same order as described in Section 1.2 “PIC32 Functionality and Features”. 
You can refer to Figure 1-1 for their locations on the board.

2.1.1 Processor Support

The PIC32 USB Starter Kit III is designed with a permanently mounted (i.e., soldered) 
PIC32MX470F512L processor.

2.1.2 Power Supply

There are two ways to supply power to the PIC32 USB Starter Kit III:

• USB bus power connected to the USB debug connector, J3

• An external application board with a regulated DC power supply that provides +5V 
can be connected to the J1 application board connector that is provided on the 
bottom side of the board

One green LED, PWR (D7), is provided to indicate the PIC32 microcontroller is 
powered.

2.1.3 Debug USB Connectivity

The PIC32 USB Starter Kit III includes a PIC24FJ256GB106 that provides debugger 
connectivity over USB PKOB. The PIC24FJ256GB106 is hard-wired to the PIC32 
device to provide protocol translation through the I/O pins of the PIC24FJ256GB106 to 
the ICSP™ pins of the PIC32 device.

The PIC32 USB Starter Kit III currently uses the ICSP pins of the PIC32 device for 
programming and debugging.

2.1.4 PIC32 USB Connectivity

The following are three possible ways to connect to the PIC32MX470F512L:

• HOST mode – Connect the device to the Type A connector J5, which is located on 
the top side of the starter kit. If using the Debug USB port to power the Host port, 
install jumper JP1 to short the back-power prevention diode. Note that a maximum 
of ~400 mA can be supplied from the Debug USB port to the Host port using this 
method. If full 500 mA supply is needed, an external supply must be connected to 
the application board, and the jumper JP1 must be removed to prevent back-
powering the Debug USB port.
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• DEVICE mode – Connect the debug Mini-B USB cable to port J3 and this cable 
will be plugged into the Host USB port to provide power and for debugging, if nec-
essary. Then connect the starter kit to the Host using a cable with a Type-B Micro 
connector to the starter kit’s Micro A/B port J4, located on the bottom side of the 
starter kit. Connect the other end of this cable to the Host for the DEVICE mode 
communication. Jumper JP1 should be removed.

• OTG mode – Connect the starter kit to the OTG device using an OTG Micro A/B 
cable to the Micro A/B port J4, located on the bottom side of the starter kit. The 
starter kit provides an on-board power supply capable of providing 120 mA (maxi-
mum). This supply is controlled by the PIC32MX470F512L microcontroller. 
Jumper JP1 should be removed.

2.1.5 Switches

Three push button switches provide the following functionality:

• SW1: Active-low switch connected to RD6

• SW2: Active-low switch connected to RD7

• SW3: Active-low switch connected to RD13

These switches do not have any debounce circuitry and require the use of internal 
pull-up resistors, which allows the investigation of software debounce techniques. 
When idle, the switches are pulled high (+3.3V), and when pressed, they are grounded. 

2.1.6 LEDs

The three LEDs, LED1, LED2, and LED3, are connected to RD0, RD1, and RD2 of 
PORTD of the processor. The PORTD pins are set high to illuminate the LEDs.

2.1.7 Oscillator Options

The installed microcontroller has an oscillator circuit connected to it. The main oscillator 
uses an 8 MHz crystal (Y1) and functions as the controller’s Primary Oscillator. Use of 
an external crystal is required to develop USB applications. The USB specification 
dictates a frequency tolerance of +/- 0.25% for full speed. Non-USB applications can 
use the internal oscillators. The starter kit also has provisions for an external Secondary 
Oscillator (Y2); however, this is not populated. 

The PIC24FJ256GB106 is independently clocked and has its own 12 MHz crystal (Y3).

2.1.8 120-Pin Modular Expansion Connector

The PIC32 USB Starter Kit III is designed with a 120-pin modular expansion interface, 
which allows the board to provide basic generic functionality now, and easy 
extendability to new technologies as they become available.

TABLE 2-1: STARTER KIT CONNECTOR PART NUMBERS

Connector HIROSE Electric PN

Starter Kit Connector FX10A-120P/12-SV1(71)

Application Board Connector FX10A-120S/12-SV(71)
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Appendix A. Board Layout and Schematics

A.1 PIC32 USB STARTER KIT III DEVELOPMENT BOARD BLOCK DIAGRAM

FIGURE A-1: HIGH-LEVEL BLOCK DIAGRAM OF THE PIC32 USB STARTER KIT III BOARD
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A.2 PIC32 USB STARTER KIT III BOARD LAYOUT

FIGURE A-2: PIC32 USB STARTER KIT III LAYOUT (TOP ASSEMBLY)
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FIGURE A-3: PIC32 USB STARTER KIT III LAYOUT (BOTTOM ASSEMBLY)
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A.3 PIC32 USB STARTER KIT III BOARD SCHEMATICS

FIGURE A-4: PIC32 USB STARTER KIT III SCHEMATICS (PIC32MX CPU)
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FIGURE A-5: PIC32 USB STARTER KIT III SCHEMATICS (DEBUG CPU)
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FIGURE A-6: PIC32 USB STARTER KIT III SCHEMATICS 
(APPLICATION BOARD CONNECTOR)
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FIGURE A-7: PIC32 USB STARTER KIT III SCHEMATICS (POWER SUPPLY)

FIGURE A-8: PIC32 USB STARTER KIT III SCHEMATICS (USB OTG/DEVICE POWER SUPPLY)
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FIGURE A-9: PIC32 USB STARTER KIT III SCHEMATICS (USB HOST POWER SUPPLY)

FIGURE A-10: PIC32 USB STARTER KIT III SCHEMATICS (SWITCHES AND LEDS)
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Appendix B. Bill of Materials

B.1 PIC32 USB STARTER KIT III BILL OF MATERIALS

TABLE B-1: PIC32 USB STARTER KIT III BILL OF MATERIALS

Reference Description Manufacturer Part No.

C1, C2, C3, 
C4, C5, C6, 
C7, C16, C19, 
C21, C25, 
C26, C27, 
C28, C29

CAP CER .10 µF 50V X7R 0603 TDK Corporation C1608X7R1H104M

C9, C10 CAP CER 20 PF 50V 5% NP0 0603 TDK Corporation C1608C0G1H200J

C15, C17 CAP CER 2.2 µF 16V X5R 0603 TDK Corporation C1608X5R1C225K

C18 CAP CER 10000 pF 50V X7R 0603 TDK Corporation C1608X7R1H103M

C20, C30, C31 CAP CER 1.0 µF 16V X5R 10% 0603 TDK Corporation C1608X5R1C105K

C22, C23 CAP CER 8 pF 50V NP0 0603 Murata Electronics North 
America

GRM1885C1H8R0DZ01D

C8, C24, C32, 
C33

CAP CER 10 µF 16V Y5V 0805 Murata Electronics North 
America

GRM21BF51C106ZE15L

C14 CAP CER 4.7 µF 10V Y5V 0603 Taiyo Yuden JMK107BJ475KA-T

C13 CAP CER 100 µF 6.3V Y5V 1206 Murata Electronics North 
America

GRM31CF50J107ZE01L

R1, R24, R25, 
R40

RES 4.7 K 1/10W 1% 0603 SMD Stackpole Electronics Inc. RMCF0603FT4K70

R2, R3, R4, 
R9, R10, R21, 
R22, R23, R46

RES 330  1/10W 1% 0603 SMD Stackpole Electronics Inc. RMCF0603FT330R

R5, R13, R15, 
R16, R19, 
R31, R32, 
R33, R34

RES 10 K 1/10W 1% 0603 SMD Stackpole Electronics Inc. RMCF0603FT10K0

R6, R26, R27, 
R36

RES 0.0  1/10W 0603 SMD Panasonic - ECG ERJ-3GEY0R00V

R7, R18 RES 200 K 1/10W 1% 0603 SMD Stackpole Electronics Inc. RMCF0603FT200K

R11 RES 1 K 1/10W 1% 0603 SMD Stackpole Electronics Inc. RMCF0603FT1K00

R12 RES 3.16 K 1/10W 1% 0603 SMD Yageo RC0603FR-073K16L

R14 RES 100  1/10W 5% 0603 SMD Yageo RC0603JR-07100RL

R20, R29, R30 RES 2.21 K 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF2211V

R28 RES 3.92 K 1/10W 1% 0603 SMD Yageo RC0603FR-073K92L

R35, R42, 
R43, R44

RES 100 K 1/10W 1% 0603 SMD Stackpole Electronics Inc. RMCF0603FT100K

R37 RES 100  1/4W 1% 1206 SMD Yageo RC1206FR-07100RL

D1, D2 DIODE SCHOTTKY 20V 0.5A SOD123 ON Semiconductor MBR0520LT1G
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D3 LED, SMD, RED, 0603 package Kingbright Corp. APT1608EC

D4 LED, SMD, YEL, 0603 package Kingbright Corp. APT1608YC

D5, D6, D7 LED, SMD, GRN, 0603 package Kingbright Corp. APT1608SGC

J1 CONN_CL570-0103 Hirose Electric Co. Ltd. FX10B-120P/12-SV1(71)

J3 CONN RECEPT MINI USB 2.0 5 POS Hirose Electric Co. Ltd. UX60-MB-5ST

J4 CONN RCPT MICRO USB AB SMD R/A Hirose Electric Co. Ltd. ZX62-AB-5PA(11)

J5 CONN USB TYPE A R/A BLACK On Shore Technology Inc. USB-A1HSB6

JP1 CONN HEADER .100 SINGL STR 2 POS Sullins PBC02SAAN

Q1 TRANS SS PNP 40V 300 MW SOT23 Micro Commercial Co. MMBT3906-TP

Q2, Q3 TRANSISTOR NPN GP 40V SOT23 Micro Commercial Co. MMBT3904-TP

S1, S2, S3 SWITCH TACTILE SPST-NO 0.05A 12V C&K Electronics PTS635SK25SMTR LFS

U1 PIC32MX470F512L-I/PT Microchip Technology Inc. PIC32MX470F512L-I/PT

U2 IC PIC MCU FLASH 256K 64-pin TQFP Microchip Technology Inc. PIC24FJ256GB106-I/PT

U3 IC REG LDO 1.5A 3.3V 8DFN Microchip Technology Inc. MCP1727-3302E/MF

U4 IC EEPROM 256 kilobit 10 MHz 8 TSSOP Microchip Technology Inc. 25LC256-I/ST

U5 IC MULT CONFIG 3.3/5V .12A 8 MSOP Microchip Technology Inc. MCP1253-33X50I/MS

U6 IC PWR DIST SWITCH SNGL SOT23-5 Texas Instruments TPS2051BDBVR

U7 IC SWITCH LOAD FULL FUNC SOT23-5 Fairchild FPF2104

Y1 CRYSTAL 8 MHz 20 pF SMD Fox Electronics FQ7050B-8

Y3 CRYSTAL 12 MHz 8 PF SMD NDK NX3225SA-12.000000 MHZ

+3.3V_PKOB, 
GND

PC TEST POINT MINIATURE SMT Keystone Electronics 5015

“Feet” BUMPON CYLINDRICAL .375X.135 BLK 3M SJ61A8

C11, C12 
(DNP)

CAP CER 11PF 50V 5% NP0 0603 TDK Corporation C1608C0G1H110J

Y2 (DNP) CRYSTAL 32 kHz 12.5 pF CYL ECS Inc. ECS-.320-12.5-13X

MH1 (DNP) 0.120 Diameter hole, unplated DNP DNP (120 mm unplated 
hole)

J2 (DNP) CONN HEADER .050" 6 POS PCB GOLD SULLINS GRPB061VWVN-RC

R8, R17, R38, 
R39, R41 
(DNP)

RES0603 DNP DNP DNP (RES0603)

TABLE B-1: PIC32 USB STARTER KIT III BILL OF MATERIALS (CONTINUED)

Reference Description Manufacturer Part No.
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